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Notice 
1. All information included in this document is current as of the date this document is issued. Such information, however, is 

subject to change without any prior notice. Before purchasing or using any Renesas Electronics products listed herein, please 
confirm the latest product information with a Renesas Electronics sales office. Also, please pay regular and careful attention to 
additional and different information to be disclosed by Renesas Electronics such as that disclosed through our website. 

2. Renesas Electronics does not assume any liability for infringement of patents, copyrights, or other intellectual property rights 
of third parties by or arising from the use of Renesas Electronics products or technical information described in this document.  
No license, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights 
of Renesas Electronics or others. 

3. You should not alter, modify, copy, or otherwise misappropriate any Renesas Electronics product, whether in whole or in part. 
4. Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of 

semiconductor products and application examples.  You are fully responsible for the incorporation of these circuits, software, 
and information in the design of your equipment.  Renesas Electronics assumes no responsibility for any losses incurred by 
you or third parties arising from the use of these circuits, software, or information. 

5. When exporting the products or technology described in this document, you should comply with the applicable export control 
laws and regulations and follow the procedures required by such laws and regulations.  You should not use Renesas 
Electronics products or the technology described in this document for any purpose relating to military applications or use by 
the military, including but not limited to the development of weapons of mass destruction.  Renesas Electronics products and 
technology may not be used for or incorporated into any products or systems whose manufacture, use, or sale is prohibited 
under any applicable domestic or foreign laws or regulations. 

6. Renesas Electronics has used reasonable care in preparing the information included in this document, but Renesas Electronics 
does not warrant that such information is error free.  Renesas Electronics assumes no liability whatsoever for any damages 
incurred by you resulting from errors in or omissions from the information included herein. 

7. Renesas Electronics products are classified according to the following three quality grades:  “Standard”, “High Quality”, and 
“Specific”.  The recommended applications for each Renesas Electronics product depends on the product’s quality grade, as 
indicated below.  You must check the quality grade of each Renesas Electronics product before using it in a particular 
application.  You may not use any Renesas Electronics product for any application categorized as “Specific” without the prior 
written consent of Renesas Electronics.  Further, you may not use any Renesas Electronics product for any application for 
which it is not intended without the prior written consent of Renesas Electronics.  Renesas Electronics shall not be in any way 
liable for any damages or losses incurred by you or third parties arising from the use of any Renesas Electronics product for an 
application categorized as “Specific” or for which the product is not intended where you have failed to obtain the prior written 
consent of Renesas Electronics.  The quality grade of each Renesas Electronics product is “Standard” unless otherwise 
expressly specified in a Renesas Electronics data sheets or data books, etc. 

“Standard”: Computers; office equipment; communications equipment; test and measurement equipment; audio and visual 
equipment; home electronic appliances; machine tools; personal electronic equipment; and industrial robots. 

“High Quality”: Transportation equipment (automobiles, trains, ships, etc.); traffic control systems; anti-disaster systems; anti-
crime systems; safety equipment; and medical equipment not specifically designed for life support. 

“Specific”:  Aircraft; aerospace equipment; submersible repeaters; nuclear reactor control systems; medical equipment or 
systems for life support (e.g. artificial life support devices or systems), surgical implantations, or healthcare 
intervention (e.g. excision, etc.), and any other applications or purposes that pose a direct threat to human life. 

8. You should use the Renesas Electronics products described in this document within the range specified by Renesas Electronics, 
especially with respect to the maximum rating, operating supply voltage range, movement power voltage range, heat radiation 
characteristics, installation and other product characteristics. Renesas Electronics shall have no liability for malfunctions or 
damages arising out of the use of Renesas Electronics products beyond such specified ranges. 

9. Although Renesas Electronics endeavors to improve the quality and reliability of its products, semiconductor products have 
specific characteristics such as the occurrence of failure at a certain rate and malfunctions under certain use conditions. Further, 
Renesas Electronics products are not subject to radiation resistance design.  Please be sure to implement safety measures to 
guard them against the possibility of physical injury, and injury or damage caused by fire in the event of the failure of a 
Renesas Electronics product, such as safety design for hardware and software including but not limited to redundancy, fire 
control and malfunction prevention, appropriate treatment for aging degradation or any other appropriate measures.  Because 
the evaluation of microcomputer software alone is very difficult, please evaluate the safety of the final products or system 
manufactured by you. 

10. Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental 
compatibility of each Renesas Electronics product.  Please use Renesas Electronics products in compliance with all applicable 
laws and regulations that regulate the inclusion or use of controlled substances, including without limitation, the EU RoHS 
Directive.  Renesas Electronics assumes no liability for damages or losses occurring as a result of your noncompliance with 
applicable laws and regulations. 

11. This document may not be reproduced or duplicated, in any form, in whole or in part, without prior written consent of Renesas 
Electronics. 

12. Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this 
document or Renesas Electronics products, or if you have any other inquiries. 

(Note 1) “Renesas Electronics” as used in this document means Renesas Electronics Corporation and also includes its majority-
owned subsidiaries. 

(Note 2) “Renesas Electronics product(s)” means any product developed or manufactured by or for Renesas Electronics. 
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SH/Tiny Series (SH7125) E10A-USB Emulator 
How to Use Command Lines (Command Batch Files) 

Overview 
The SH/Tiny series (SH7125) E10A-USB emulator is available for creating and executing a command 

batch file through the command line function. It is also possible to set the execution timing and execute the 
command batch file. This document describes how to create and execute the command batch file by using 
the E10A-USB emulator. 

The contents described in this document generally apply for emulators which use the High-performance 
Embedded Workshop manufactured by Renesas. 
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1. Specifications 
The Renesas High-performance Embedded Workshop has a command line function, which is available on 

the [Command Line] window, and the E10A-USB emulator supports debugging operation with the use of this 
function. When a file describing each command in the input order is created, command batch processing is 
enabled. In addition, the executed result of the command line is recorded as a log file, which is useful for 
creating a command batch file. 

Two methods can be used to execute the command batch file: selecting a file on the [Command Line] 
window and setting an execution timing to execute the file upon the generation of that timing. 

 

2. Functional Descriptions 
This document explains how to create and execute a batch file by using the sample program included in 

the package that can be downloaded from the Renesas website. 

The version of each tool is as follows: 

E10A-USB Emulator Software V.2.08 Release 01 

 

3. Software Preparation 

3.1 Introduction 
Install the software provided in the CD-ROM of the E10A-USB emulator to expand the sample program 

(tutorial workspace) to be used with this document on your personal computer.  

The software in the CD-ROM of the E10A-USB emulator can also be installed on a personal computer in 
which the High-performance Embedded Workshop has already been installed. In this case, some dialog 
boxes may be skipped in the installation process. 

 

3.2 Installing the E10A-USB Emulator Software 
Execute HewInstMan.exe from the CD-ROM of the E10A-USB emulator. 

For details on installation, refer to the setup guide for the E10A-USB emulator on the Renesas website and 
follow the directions shown on the screen during installation. The full installation procedure is not described 
here. 

 

3.3 Installing Other Necessary Software 
(1) When the auto-update utility is selected upon installation of software, it is possible to check the latest 

version of tools on the Internet. 
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4. Operations 
This section explains how to activate the High-performance Embedded Workshop (HEW) and how to 

create and execute the command batch file in the following steps. 

 

Activating the HEW 

Executing a command batch file with execution timing

END 

Creating and executing a command batch file 

Creating a log file 

Opening a workspace 

START  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 4.1  Procedures for Sample Program Execution 

 

4.1 Activating the High-performance Embedded Workshop 
First, connect the E10A-USB emulator with the user system to the host computer via the USB cable and 

check that debugging is enabled. 

Next, activate the High-performance Embedded Workshop by opening the [Start] menu and selecting [All 
Programs], [Renesas], [High-performance Embedded Workshop], and [High-performance Embedded 
Workshop], in that order. 
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4.2 Opening a Workspace 
(1) The [Welcome!] dialog box will appear on the High-performance Embedded Workshop screen. 

 
 

Select the [Browse to another project workspace] radio button in the [Welcome!] dialog box and click on 
the [OK] button. 
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(2) The [Open Workspace] dialog box will appear. 

 
When the software from the CD-ROM of this product has been installed, workspace “Tutorial.hws” is 
stored in the folder structure shown below (standard location). Specify the correct location by opening 
the folders in order. Select the workspace “Tutorial.hws” and click on the [Open] button. 
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Note: The above directory may not be specifiable depending on the software version. In this case, 
select the following directory. 

 

<High-performance Embedded Workshop installation directory> 
¥Tools¥Renesas¥DebugComp¥Platform¥E10-USB\SH-2¥SH7080Series¥Tutorial_SH7125MCUSeries 

Directory examples: 
C: ¥hew3¥Tools¥Renesas¥DebugComp¥Platform¥E10-USB¥SH-2¥SH7080Series¥Tutorial_SH7125MCUSeries 

C: ¥hew2¥Tools¥Renesas¥DebugComp¥Platform¥E10-USB¥SH-2¥SH7080Series¥Tutorial_SH7125MCUSeries 

 

(3) If the workspace version is not the latest available, the following dialog box will appear. To update to the 
new version, click on the [OK] button. 

 

C:¥WorkSpace 
  └Tutorial 
    └E10A-USB 
      └SH2 
        └SH7080Series 
          └Tutorial_SH7125MCUSeries 

└Tutorial.hws 

C:¥WorkSpace¥Tutorial¥E10A-USB¥SH-2¥SH7080Series¥Tutorial_SH7125MCUSeries¥Tutorial.hws
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(4) If the following dialog box appears, click on the [OK] button. 

 
 

(5) The [Select Emulator mode] dialog box will appear. Select [SH7125_Debug_MCU_BOARD] for the 
[Device] combo box and [E10A-USB Emulator] for [Mode], and click on the [OK] button. 
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(6) The [heush7080] dialog box will appear for the first time only. Click on the [OK] button. 

 
 

(7) The [Driver Details] dialog box will appear for the first time only. Select “Renesas E-Series USB Driver” 
for [Driver] and click on the [Close] button. 

 

These items are automatically selected. 
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(8) The [heush7080] dialog box will appear. After the reset switch (RESET_SW) is pushed once on the 
hardware, click on the [OK] button. 

 
In the HS7125EDB01H/1, a board in the user system explained in this document, SW4 corresponds to 
RESET_SW. 

 

(9) The [System Clock] dialog box will appear. Set the external clock frequency for use and click on the [OK] 
button. 

 
In this document, the external clock frequency is input as 10.00 MHz. 

 

(10) The [ID Code] dialog box will appear. In this document, do not change [E10A] (initial value) for [Please 
input ID Code]; simply click on the [OK] button. 
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(11) The E10A-USB emulator will be connected and operation on the High-performance Embedded 
Workshop screen be enabled. When the connection is complete, [Connected] will be displayed on the 
[Debug] tab in the [Output] window. 
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4.3 Creating a Log File 
First, the following describes how to create a log file that is useful for creating a command batch file. 

(1) Select [Command Line] from the [View] menu. 

 
 

  The [Command Line] window will appear. 
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(2) Click on the [Command Line] window with the right-hand mouse button and select [Set log File…]. 
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(3) The [Open Log File] dialog box will appear. Click on [Browse] to select the output destination of the log 
file and click on the [OK] button. The file name is set as “logsample” here. 

 
 

 
After clicking on [OK], logging starts in the [Command Line] window and all commands that have been 
entered are recorded in the log file. 
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(4) Input the following commands in the [Command Line] window. These commands mean that any data is 
written in part of the on-chip RAM area (H’FFFFA000 to H’FFFFA0FF) of the SH7125 MCU to dump the 
result. 

After commands have been input, select the [Toggle Logging] icon to end logging (if the icon has been 
pressed, logging is started). 

 

The input commands are underlined in red. 

Dumped result 

Note: For the memory area, refer to the memory map in the hardware manual of the target MCU. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

REJ06J0042-0100/Rev.1.00 2008.3 Page 11 of 29 



 SH/Tiny Series (SH7125) E10A-USB Emulator 
How to Use Command Lines (Command Batch Files) 

(5) Command lines are listed in the emulator manual or online help file. Even if you don’t know details of 
commands, when a character is input on the [Command Line] window, there is a useful function that 
shows a guide for related commands and parameters. 

 

 
 

 
 

  When a file name is specified in a command such as file_load, it is convenient to click with the right-hand 
mouse button on [Browse…] in the [Command Line] window and select the name in the browser. 
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4.4 Creating and Executing a Command Batch File 
This section explains how to create and execute the command batch file using “logsample.log”, created in 

section 4.3, as an example. 

(1) Extract only the commands that have been input in the [Command Line] window from the created log file, 
using a text editor, etc. 

 
 

(2) Save the extracted file as an “.hdc” type. Here, the file is called “logsample.hdc”. 
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(3) Select the [Batch File] icon in the [Command Line] window. 

 
 

(4) The [Set Batch File] dialog box will appear. Click on [Browse…] to select the batch file to be executed 
and click on the [Play] button. The created file “logsample.hdc” is selected here. 

 
 

(5) The contents of the executed command batch file are displayed in the [Command Line] window. It is 
possible to check that commands the same as those in the created command batch file have been 
executed. 
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4.5 Executing a Command Batch File with Execution Timing 
This section explains how to set the execution timing of the command batch file and execute the file upon 

the generation of that timing. 

(1) Select [Debug Settings…] from the [Debug] menu. 

 
 

(2) The [Debug Settings] dialog box will appear. Select the execution timing in the [Command batch file 
load timing] combo box on the [Options] tab and click on [Add…]. Here, “At target connection” is 
selected. 
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There are four timings for execution of the command batch file: 

“At target connection” → The file is executed when the E10A-USB emulator is connected to the user system. 

“Before download of modules” → The file is executed immediately before starting download of the program. 

“After download of modules” → The file is executed when downloading of the program ends. 

“After reset” → The file is executed when the CPU is reset. 

 

(3) The [Command Line File] dialog box will appear. Click on [Browse…] to select the command batch file 
to be executed and click on the [OK] button. The file “logsample.hdc”, created in section 4.4, is selected 
here. 

 
 

(4) In the [Debug Settings] dialog box, the address of the selected command batch file is displayed in the 
[Command line batch processing] field on the [Options] tab. If the selected command batch file is correct, 
click on the [OK] button. 

 
The [Command line batch processing] field is displayed for each execution timing. It is possible to set 
batch files for each of the four execution timings. 
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(5)  Check if the command batch file is actually executed when the E10A-USB emulator is connected. 
Select the [Disconnect] icon to disconnect the E10A-USB emulator. 

 
 

(6)  Select the [Connect] icon and reconnect the E10A-USB emulator (for the procedure, refer to (4) to (8) 
in section 4.2). 

 
 

(7) When connection is complete, the contents of the executed command batch file are displayed in the 
[Command Line] window. It is possible to check that commands the same as those in the selected 
command batch file have been executed. 
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(8) Next, the following describes an example where the execution timing is “After reset” and a command 
batch file having the following contents is set and executed. (To create the command batch file and set 
the execution timing, refer to section 4.3 to (4) in section 4.5.) 

【Contents of the Command Batch File】 

These commands mean that any data is written in general-purpose registers R0 to R14 of the 
SH7125 MCU. 

As described in (1) and (2) in section 4.4, extract only the commands that have been input in the 
[Command Line] window from the created log file, using a text editor, etc., and save the extracted file 
as an “.hdc” type. Here, the file is called “logsample2.hdc”. 

 
 

   【Setting Contents of the Execution Timing】 

Specify the [Command batch file load timing] combo box as “After reset”, click on [Add…], and select 
the “logsample2.hdc” file. 
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(9) To check if the above command batch file has been executed correctly after CPU reset, open the 
[Register] window. Select [View] -> [CPU] -> [Registers]. 

 
 

The [Register] window will open. 
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(10) When the [Reset CPU] icon is selected, the contents of the executed command batch file will be 
displayed in the [Command Line] window, which will show if the value in the [Register] window has been 
rewritten. 
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(11) Next, the following describes an example where the execution timing is “Before download of modules” 
or “After download of modules” and the command batch file having the following contents is set and 
executed. (To create the command batch file and set the execution timing, refer to section 4.3 to (4) in 
section 4.5.) 

Note: 

When multiple load modules are loaded, note that the command batch file cannot be changed in 
each file (the extension is “.abs”). 

 

【Contents of the Command Batch File for “Before download of modules”】 

These commands mean that any data is written in part of the on-chip RAM area (H’FFFFA100 to 
H’FFFFA1FF) of the SH7125 MCU to dump the result. 

As described in (1) and (2) in section 4.4, extract only the commands that have been input in the 
[Command Line] window from the created log file, using a text editor, etc., and save the extracted file 
as an “.hdc” type. Here, the file is called “logsample3.hdc”. 

 
 

【Setting Contents of the Execution Timing for “Before download of modules”】 

  Specify the [Command batch file load timing] combo box as “Before download of modules”, click on 
[Add…], and select the “logsample3.hdc” file. 
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【Contents of the Command Batch File for “After download of modules”】 

These commands mean that “H’00” is written in part of the on-chip RAM area (H’FFFFA100 to 
H’FFFFA1FF) of the SH7125 MCU to dump the result. 

As described in (1) and (2) in section 4.4, extract only the commands that have been input in the 
[Command Line] window from the created log file, using a text editor, etc., and save the extracted file 
as an “.hdc” type. Here, the file is called “logsample4.hdc”. 

 
 

【Setting Contents of the Execution Timing for “After download of modules”】 

Specify the [Command batch file load timing] combo box as “After download of modules”, click on 
[Add…], and select the “logsample4.hdc” file. 

 
 

(12) To download the program, double-click on [Tutorial.abs-00000000] of [Download modules] in 
[Workspace]. 

 
   When the program has been downloaded, a downward arrow is added to the icon. 
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(13) When the program is downloaded, a command batch file that has been set at the execution timing of 
“Before download of modules” is executed. When the program download is complete, a command batch 
file that has been set at the execution timing of “After download of modules” is executed. The executed 
results are then displayed in the [Command Line] window. 

 

Executed after the program 

download is complete 

Executed before the program is 

downloaded 

 

This is the end of the explanation on creating and executing the command batch file. 
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5. Frequently Asked Questions 

5.1 Is it possible to reuse a command line which has been previously input? 
 A command line which has been previously input can be displayed again when the upward arrow is 
clicked while the control key of the keyboard is pressed at the lowest position when the prompt (“>”) is 
displayed on the [Command Line] window. When such a command is displayed again, it can be edited 
and executed by using the leftward or rightward arrow key. 

 

5.2 Is there any method to use the command batch file effectively? 
(１) Automatically setting the bus state controller (BSC) 

When the external memory (SDRAM) is connected to the MCU, correct access may be implemented 
for the first time when the bus state controller is set. In this case, prepare the command batch file that 
uses the “memory_fill” command and substitutes the set values of each register of the bus state 
controller. When this command batch file is set for the execution timing “At target connection” or “After 
reset”, it becomes possible to access the external memory area or download the program to that area 
immediately after the emulator is started or the reset command is executed. 

 

[Example of a Command Batch File] 

! memory_fill <start> <end> <data> <mode> <state>  /* <state>: N = not verify */ 

memory_fill  h’a4fd0008  h’a4fd000b h’36db0600  long  n 

memory_fill  h’a4fd000c  h’a4fd000f   h’36db4600  long  n 

memory_fill  h’a4fd0010  h’a4fd0011 h’55aa  word  n 

   … 

 

Note: To use this method to set the bus state controller for the MCU, refer to the set value by using a 
keyword such as ‘bus state controller’ or ‘SDRAM’ to search FAQs in the hardware manual of each 
MCU or on the Renesas website. 

 

(２) Example of external address enable (EAE) operation in the H8S bus control register (BCRL) 

In the H8S/2655 MCU, by default, the last half of the on-chip ROM area may be the external address. 
In this case, when the next command batch file is created and registered for “Before download of 
modules”, the program can be downloaded correctly within the whole on-chip ROM area. 

 

[Example of a Command Batch File] 

! If H8S/2655, BCRL = h’fed5, EAE = bit 5 (0 = on-chip ROM, 1 = external address) 

memory_fill  h’fed5  h’fed5  h’1c 

 

5.3 Is there any note when a file is specified with the command line? 
 When a file is specified with the command line, use a placeholder. When a directory that is not 
included in the placeholder is specified, use an absolute path. If an absolute path is used, the file cannot 
be correctly referred to when it is moved to other machines or an environment where the contents of a 
path are different; in such a case, reset the file. 
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5.4 If “Not currently available” is displayed during execution of a command batch file, 
what steps should be taken? 

 Insert the Sleep command. Adjust the sleep time depending on the operating environment. 

 

[Example of a Command Batch File] 

! Method to display “Not currently available” with the memory_fill command (approximately a 
3-second wait is inserted) 

memory_fill  h’0000 h’ffff 0 

sleep d’3000 

 

5.5 Is there any list of commands that can be used for the command line? 
 A list in the help menu of the High-performance Embedded Workshop indicates the usable commands 
and formats. Select [Emulator Help] from the [Help] menu. 
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When [Command line Table] in [Contents] is selected, a list of command lines is displayed. To see the 
details of a command format, click on a command name. 

 

Click on the command name.
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 Details of the selected command will be displayed. 

 
The emulator help information is stored in a folder created at installation of the High-performance 
Embedded Workshop; this folder is named “Emulator.chm”. 

【Example of a Folder】 

C:¥Program Files¥Renesas¥Hew¥Tools¥Renesas¥DebugComp¥Platform¥E10A-USB¥SH-2¥SH7080Series 
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6. Related Documents 
The E10A-USB emulator and High-performance Embedded Workshop provide many other useful 

functions not mentioned in this document. Please refer to the following related documents for important 
information such as detailed specifications, technical information, or restrictions on each product. 

 

【Documents Related to the E10A-USB Emulator】 

・ SuperH™ Family E10A-USB Emulator User's Manual 

・ SuperH™ Family E10A-USB Emulator Additional Document for User's Manual 

(Supplementary Information on Using the SH7125 Series Debugging MCU Board) 

・ SuperH™ Family E10A-USB Emulator Additional Document for User's Manual 

(Supplementary Information on Using the SH7125 and SH7124) 

・ Limitations on SuperH™ Family E10A-USB Emulator 

 

 

【Documents Related to High-Performance Embedded Workshop】 

・ High-performance Embedded Workshop User's Manual 

・ High-performance Embedded Workshop Release Note 

 

 

【Documents Related to MCU】 

・ SH7125 Group, SH7124 Group Hardware Manual 

・ SH-1/SH-2/SH-DSP Software Manual 

 

 

【Document Related to SuperH™ Family C/C++ Compiler Package】 

・ SuperH™ C/C++ Compiler Package User's Manual 

 

 

Visit the following Renesas websites for information on this product: 

Global site:  http://www.renesas.com/e10a_usb

Japanese site: http://japan.renesas.com/e10a_usb
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Renesas Website and Customer Support 
Renesas Technology Website: 

http://www.renesas.com/
 
Customer Support: 

http://www.renesas.com/inquiry
csc@renesas.com
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1. This document is provided for reference purposes only so that Renesas customers may select the appropriate Renesas 

products for their use. Renesas neither makes warranties or representations with respect to the accuracy or 
completeness of the information contained in this document nor grants any license to any intellectual property rights 
or any other rights of Renesas or any third party with respect to the information in this document.  

2. Renesas shall have no liability for damages or infringement of any intellectual property or other rights arising out of 
the use of any information in this document, including, but not limited to, product data, diagrams, charts, programs, 
algorithms, and application circuit examples.  

3. You should not use the products or the technology described in this document for the purpose of military applications 
such as the development of weapons of mass destruction or for the purpose of any other military use. When exporting 
the products or technology described herein, you should follow the applicable export control laws and regulations, and 
procedures required by such laws and regulations.  

4. All information included in this document such as product data, diagrams, charts, programs, algorithms, and 
application circuit examples, is current as of the date this document is issued. Such information, however, is subject to 
change without any prior notice. Before purchasing or using any Renesas products listed in this document, please 
confirm the latest product information with a Renesas sales office. Also, please pay regular and careful attention to 
additional and different information to be disclosed by Renesas such as that disclosed through our website. 
(http://www.renesas.com ) 

5. Renesas has used reasonable care in compiling the information included in this document, but Renesas assumes no 
liability whatsoever for any damages incurred as a result of errors or omissions in the information included in this 
document.  

6. When using or otherwise relying on the information in this document, you should evaluate the information in light of 
the total system before deciding about the applicability of such information to the intended application. Renesas 
makes no representations, warranties or guaranties regarding the suitability of its products for any particular 
application and specifically disclaims any liability arising out of the application and use of the information in this 
document or Renesas products.  

7. With the exception of products specified by Renesas as suitable for automobile applications, Renesas products are not 
designed, manufactured or tested for applications or otherwise in systems the failure or malfunction of which may 
cause a direct threat to human life or create a risk of human injury or which require especially high quality and 
reliability such as safety systems, or equipment or systems for transportation and traffic, healthcare, combustion 
control, aerospace and aeronautics, nuclear power, or undersea communication transmission. If you are considering 
the use of our products for such purposes, please contact a Renesas sales office beforehand. Renesas shall have no 
liability for damages arising out of the uses set forth above.  

8. Notwithstanding the preceding paragraph, you should not use Renesas products for the purposes listed below: 
1) artificial life support devices or systems 
2) surgical implantations 
3) healthcare intervention (e.g., excision, administration of medication, etc.) 
4) any other purposes that pose a direct threat to human life 

Renesas shall have no liability for damages arising out of the uses set forth in the above and purchasers who elect to use 
Renesas products in any of the foregoing applications shall indemnify and hold harmless Renesas Technology Corp., its 
affiliated companies and their officers, directors, and employees against any and all damages arising out of such 
applications. 

9. You should use the products described herein within the range specified by Renesas, especially with respect to the 
maximum rating, operating supply voltage range, movement power voltage range, heat radiation characteristics, 
installation and other product characteristics. Renesas shall have no liability for malfunctions or damages arising out 
of the use of Renesas products beyond such specified ranges.  

10. Although Renesas endeavors to improve the quality and reliability of its products, IC products have specific 
characteristics such as the occurrence of failure at a certain rate and malfunctions under certain use conditions. Please 
be sure to implement safety measures to guard against the possibility of physical injury, and injury or damage caused 
by fire in the event of the failure of a Renesas product, such as safety design for hardware and software including but 
not limited to redundancy, fire control and malfunction prevention, appropriate treatment for aging degradation or any 
other applicable measures. Among others, since the evaluation of microcomputer software alone is very difficult, 
please evaluate the safety of the final products or system manufactured by you.  

11. In case Renesas products listed in this document are detached from the products to which the Renesas products are 
attached or affixed, the risk of accident such as swallowing by infants and small children is very high. You should 
implement safety measures so that Renesas products may not be easily detached from your products. Renesas shall 
have no liability for damages arising out of such detachment.  

12. You should not use the products or the technology described in this document for the purpose of military applications 
such as the development of weapons of mass destruction or for the purpose of any other military use. When exporting 
the products or technology described herein, you should follow the applicable export control laws and regulations, and 
procedures required by such laws and regulations.  

13. Please contact a Renesas sales office if you have any questions regarding the information contained in this document, 
Renesas semiconductor products, or if you have any other inquiries. 

Notes regarding these materials 

© 2008. Renesas Technology Corp., All rights reserved. 
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